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Preface
Thank you for purchasing CarDetector Viewer. We hope you enjoy using the software.
This reference gives you instructions for using CarDetector Viewer

If you have any questions about the software, please do not hesitate to contact your vendor.
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Chapter 1

Overview

This chapter covers the basic and fundamental information about CarDetector Viewer. The information

includes:

1.1 Introduction
1.2 Structure of the system
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1.1. Introduction

CarDetector Viewer is a PC-based visual system designed to view the resuit of recognizing
moving cars by auto capturing their license number plates via live video feeds of CarDetector
MiniPC. CarDetector Viewer which is connected with CarDetector MiniPC via TCP/IP protocol
for getting information of detection and show the result in the working window. CarDetector
Viewer can perform all functions like CarDetector Mobile except setting camera system.

The system also provides a search engine for reviewing the captured data, as well as the ability to
find all instances of car records by license plate number.

The alarm module of CarDetector Viewer allows the user to configure alarms to be triggered when
a given car being evaluated has a license plate number matching one in a list of user-defined
‘black-listed’ (unauthorized) vehicles.

In addition, CarDetector Viewer allows the user to input various detailed information related to the
individual driving the vehicle with a given license plate number.

1.2. Structure of the system

A complete CarDetector system requires the following components:
Input source: IR Camera, Recorder Camera or specific camera
Video capture device
Software: CarDetector Viewer, CarDetector MiniPC

The input video feed is from a camera that is connected directly to a PC with a capture card
(capture cards convert Analog signals from the camera to Digital signals which can be

processed by the computer)

CarDetector then uses DirectX 9.0c to preprocess the source data, during which CarDetector
adjusts the images for the final step: detecting and matching.

CarDetector utilizes highly sophisticated algorithms to detect when a vehicle is visible and
where to look for the license plate of the vehicle. The software then stores the image of the
license plate along with an image of the vehicle and the resolved license plate number for
cataloging.

Note:

The system must have at least one IR camera for capturing car plates.
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Due to CarDetector Viewer works with the detection result from CarDetector MiniPC so before
operating CarDetector Viewer first you must run CarDetector MiniPC.
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Chapter 2

Getting started

This chapter provides the following information regarding installation and setup of CarDetector.

2.1 System Requirements

2.2 Instaliation
2.2.1  Hardware installation
2.2.2 Camera Installation Guidelines for best results
2.2.3 CarDetector Installation
2.2.4 Removing Older Version of MySQL Server
2.2.5 Installing MySQL Server 5.0
2.2.4 Uninstalling CarDetector
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2.1. System Requirements

Please make sure your system meets the following requirements before installing CarDetector:
Processor: Intel Pentium 1V 2.8 Ghz with Hyper Threading Technology

Operating System: Microsoft Windows 2000 or MS. Windows XP Pro

Memory: 1GB RAM supported (more recommended)

Graphics Card: compatible with DirectX 9 (ATI Radeon or NVIDIA GeForce2 or higher
recommended).

Sound Card: compatible with DirectX 9 (optional)

CD-ROM drive

Speakers (optional)

Mouse

Hard Disk: 80GB or greater SATA 7200 RPM recommended

2.2 Installations

2.2.1. Installing CarDetector

Note:
Only users that have the permissions to install a new program can set up this
application. If the PC has already had MySQL installed, the user must have the
administrator rights or the suitable permissions to work with the database.

Every CarDetector system comes with an installation CD, which includes the CarDetector
software application.
Follow these instructions to install CarDetector software application onto the PC:

1. Insert the CarDetector Software Installation CD into a CD-ROM drive, and the setup process
will run automatically.
This window indicating the begining of instaliation is displayed:
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2. Wait until the reprocess is finished.

CarDetector Repo Yiewer Setup 3.1

Welcome to the InstaliShield Wizard forCarDetector Viewer

e heetd e iz and vl mnatall Dl t Matile onvour computer. To conhips chek

f{hw ¥

2. Click Next to start installing.
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CarDetector Yiewer 9etup 3.4

License Agreement

siche i e e e

VIGILANT VIDEO. SOFTWARE LICENSE AGREEMENT
CarDetector Viewer

IMPORTANT - READ CAREFULLY: THIS VIGILANT VIDEO.
SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) IS A
LEGAL AGREEMENT BETWEEN YOU (EITHER AN
INDIVIDUAL OR AN ENTITY) AND VIGILANT VIDEO.
(“LICENSOR”) FOR THE SOFTWARE PRODUCTS
IDENTIFIED ABOVE, WHICH MAY INCLUDE ASSOCIATED
SOFTWARE COMPONENTS, MEDIA, PRINTED MATERIALS,
AND “ONLINE” OR ELECTRONIC DOCUMENTATIONS. By
any of the following acts, you (“Licensee”) agree to license the
Software and to become a party to, and be bound by all of the
terms and conditions of, this Agreement:

@ | do ot accept the terme of the censz agreement

<Back || New>

3. Click | accept the terms of the license agreement to accept the End User License
Agreement. Otherwise click No to exit the installation.
If Next is clicked, the following dialog is displayed:
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CarDetector Yiewer Setup 3.4

Customer Information

B b s b ation
F raber ol rame and the nare of the comgars bor whick gou sk

I zer Mlame

Coarnpary Marme:

fnctalll, o

4  Enter your information (User Name and Company Name) and click Next.

5 The following dialog will be displayed:
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CarDetector Yiewer Setup 3.4

Setup Type

Sl pezgrarm beaturss vall be rtalled |Fegures the most deb space |

® Custam
=y Salect wkich proagram featupe s vouowant mstalled. Becommended tar advanced
b .
A

6 Select the suitable type of setup and click Next, the following dialog will be displayed:

CarDetector Yiewer Setup 3.4

Ready to Install the Program

o ballata

Clzk Inzball to beair thie inctallabion

It youwant bo revievs or change ang ob vour rstallabion etings, chok Back Chok Cancel to ext the
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7 Click Install to start installation.

CarDetector Yiewer Setup 3.4

Selup Status

Calietectar Mabale = conhguong wour v Cothaea

[nztallireg

OOCTEE4 1T datal cab

8 Wait until the installation complete. The following window will be displayed
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CarDetector Yiewer Setup 3.4

InstallShield Wizard Complete

Thuz Installzbsld Wizard bas cucoessfully nstalled Carlletector Mabile. Chob Firizh o eat the
wnzard

st Cancel }

9 Click Finish. The instaliation of the application is complete. It is recommended you to restart
your computer after finishing the installation.

After fully installing the software, it is highly recommended you restart your computer before
running the application.

The information about the version of the software is shown in the About dialog of the running
program.

2.2.2 Uninstall CarDetector

1. Select the Settings\Control Panel\Add/Remove Programs\CarDetector Viewer to
uninstall CarDetector Viewer software.
2. The uninstaller will then remove all related files from your hard disk.

Note: Images and the database created by CarDetector Viewer will not be removed, but
remain on the hard disk drive.
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Chapter 3

Operation of CarDetector Viewer

This chapter provides information on how to start up the program, define camera systems, and operate
for car detection.

3.1 Starting the application
3.2 Upgrading the Licensed Number of Feeds
3.3 Detection Setting up
3.3.1 Audible Settings
3.3.2 Alert Setting
3.3.3 Region Selecting
3.3.4 Database Cleanup
3.4. Car Detection
3.5 Alerting based on a Hot List
3.6 Import Hot List
3.7 RunPlate
3.8 Exit CarDetector Viewer
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3.1. Start the application

After installing the hardware and software, you can work with the program by starting the software:
Choose Start\Programs\Vigilant Video\CarDetector Viewer to start the program
Or you can double click on the icon of the software on the desktop after installing.

The first time you run the software, the License Code dialog will be displayed as follows:

CarDetector

Machine ID : |mmzzcosa-1uz1

Days leit : l5

Licenss code: |

Unock |  Runtid | Ciose |

After installation, the program will create a 'Site Code’ and a ‘Machine ID'’.

Please copy and send the ‘Site code’ and ‘Machine ID’ to your vendor or supplier to receive the
associated “License code” to unlock the application permanently. Please be sure to include the
number of inputs to unlock for the one system.

After receiving your license code, copy and paste it into the dialog textbox for ‘License Code’. Click
Unlock.

** Should the number of inputs change and a larger number of feeds (cameras) be required,
contact your vendor for pricing to purchase more feeds. An ‘Upgrade License’ will then be sent for
upgrading the number of concurrent feeds that can be used. Refer to the following section,
‘Upgrading the Licensed Number of Feeds’, for details on updating your system with an ‘Upgrade
License’.

You may use the application in demo mode by clicking on the Run Trial button. As a demo, the
application is only available in 14 days.

Next, you will be asked for connection information for CarDetector MiniPC by the following dialog:
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Connect ta MiniPC

ServerName:  [192168.0.11

Poit : l
Database Name : | -]
Usei Name : |
Password : '

[T Automstically connect

ltomectltmcel

Enter the IP of the server running CarDetector MiniPC.

Note:
Automatically connect: If this checkbox is checked, the program will automatically connect to
the database of CarDetector MiniPC with the entered parameters without showing this dialog
next time the application runs.

Click Connect to open communication between CarDetector Viewer and CarDetector MiniPC.

Next, you will be asked to log in the system by entering your badge number - the code of the user,
for running CarDetector:

Choose your badge number and click Login. In event that your badge number is not in the
system, type the badge and click OK; the program will confirm creating the new badge with the
following message:

? ; Badge name'01' does not exist.
'\-»?/ Do you want to create?

v ] o~ |
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Click Yes to commit.

3.2 Upgrading the Licensed Number of Feeds

Each license provided is created specifically for a certain number of live cameras (depending on
the number of feeds purchased). To increase the number of licensed feeds, please contact your
vendor. An upgrade license will be sent. To install, perform the following:

Click Powered By at the left-bottom corner of the screen to open the dialog with the information
about the license

Lot Mode

05 S BARTATE

About CarDetector

Vigilant Video

Mobile I.PR Edition
WARNING: This computar program is protected by copyright
law and international treaties, Unauthorized reproduction or
distribution of thiz program, or any portion of &, may resuit In
savere civil and eriminal penalties, and will be prosecuted to the
maximum axtent possible under taw,

. CAR DETECTCR

® Copyright ‘2 2008 Vigilant Video.

Version 3.4.061008.0855
SiteCode: EBO386ZF - MachinelD: CF7D-58D9-43581-8938 - Camerafs); 2
Upgrade license

Click ‘Upgrade License’; the Upgrade camera(s) dialog will be displayed:

Upgrade camera(s)

Stecode:  [RUIESY

Machine ID : lES%—?‘ZS—FB%-WB

Newbmmoda;]

Upgrade | [ Ciose |
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The dialog contains the information about the Site code and Machine code of the current license.

To register another license code with new number of camera(s), contact with your supplier to have
the new code.

When the new license code has been received, copy and paste it into the ‘New license code’ text
box of the ‘Upgrade camera(s) dialog and click Upgrade.

3.3 CarDetector Viewer Interface

CarDetector Viewer is a PC application which is used to show the detection result of CarDetector
MiniPC. It means CarDetector MiniPC receives an analog video stream from the cameras, and
processes license plate detection and recognition, providing color overview and IR plate scan
images for each detected plate in CarDetector Viewer.

The interface of CarDetector Viewer inciudes the following:

The Control buttons perform system functions
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The Detection Result window shows the result of your most recent plate scan

The Hit List reports any scanned plates that are on the Hot list

The Detection table shows the list of detected car numbers

3.3.1. Detection Table

The Detection Table contains the result of detecting process. The information shown in the table
includes plate images (Image), car numbers (Plate 1, Plate 2) of detected cars and the
corresponding surveillance camera.

1 . Plate2 | Camer—

3.3.2. Control Buttons

The Control buttons:

This button is used to set principle parameters and options for detection.

This button is used to view the communication statistics of the application with the
LEARN Server.

This button is used to import a list of suspect cars.

This button is used to start a shift for exporting detection result.

This button is used to end a shift for exporting detection resuit.

This button is used to add a new suspect car number to the current hot list.
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3.3.3. Hit List
The Hit List:

HIT LIST

3.3.4. Detection Result window

This button is used to search for a plate in the database

This button is used to minimize the application window

This button is used to exit the application

This is the list of suspect cars that have been detected by the
application

To see detailed information about the detected car, select its number
i the Hit List d click the View Info button

The result of detection will be shown here. The window consists of an image of detected car,

detected number(s) and its plate

image
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3.3.5. The Status Lights

Status lights consist of:

pravemmm—— This light shows the connection status of CarDetector with the LEARN
Server: Green: Connected, Red: Not connected. To view statistics
about your connection with the LEARN Server, click the Status button.

This light shows the connection status of CarDetector with the GPS
GPS

E- Link

device: Green: getting good GPS coordinates, Red: GPS device not
active

fr— This light shows the tracking location of CarDetector. Green: normal
Location status; Red: User is scanning a previously-scanned area.

3.4 Detection Setting up

To configure parameters and rules for license plate detection, perform the following:

Click the ‘Setup’ button; the following dialog will be displayed:
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S S ‘
Camera Audio  Detection  Alert Clean View Name E-Link

P~

Camera 1 - Color =i

Camera 1-1R

Camera 2 - Color ”

In the dialog, you can define a sound for alerting when there is any license plated detected or a hot
plate detected. You can also choose the character matching method during the detection, set up
the camera system and select the region where you intend to use the application for detection.

Audio Settings
Alert Setting
Detection Selecting
Cleanup Database
View Name

E-Link

After configuring necessary information for detection, click the Apply button; the changes will be
updated to the database of the system. These settings will effect on the performance of
CarDetector MiniPC.

3.4.1. Audio Settings

Audio Settings allows you to choose the audio file for alerting the operator car numbers in the hot
list.
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Alert on Detection
View Name sound Alert
Exact match Alert

Cne off match Alert

Alert level: High

Alert level: Medium

Alert level: Low

Alert on Detection: allows defining a sound that will be played when any license plate is
detected by the application.

View Name sound Alert: allows alerting by sound the name of the view on detection of a hot
list plate.

Exact match Alert: allows defining a sound that will be played when a license plate is detected
exactly matches any plate in the Hot List.

One off match Alert: allows defining a sound that will be played when a detected license plate
is just one character different from the characters of any plate in the Hot List.

Alert level: High: allows defining a sound that will be played when a hot list plate with high
alert level is detected

Alert level: Medium: allows defining a sound that will be played when a hot list plate with
medium alert level is detected

Alert level: Low: allows defining a sound that will be played when a hot list plate with low alert
level is detected

To activate playing a sound for any of these detection events, make a check on the
corresponding option. The alarm sound will be the default one.

If you want to define the audio file, click the Browse button; the Open dialog will be displayed:
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Filename: | I Open I

Files of type:  [Sound Files (" wav) > Carcel_|
0
™ Open as read-only d

Choose the desired sound in the available Audio folder or from others and click Open.
After completing audio setting, click Apply to commit configuration.

Click Close to close the tab window.

3.4.2. Alert Setting

Alert Match allows defining the method of matching when searching for detected plates on the hot
list.
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Camera  Audio Detection  Alert Clean View Name E- Link

Exact match

1 oft match

Exact match: make an alarm sound when any detected plate number exactly matches all
characters of a plate number on the hot list

1 off match: make an alarm sound when there any detected plate number has only one
character difference from one of those of any plate number in the hot list (including the case if a
plate with less or more than one character). See the following figure

Click Apply to commit configuration.

Click Close to close the tab window.

3.4.3. Region Selecting

This tab allows you to select an appropriate region for detection

21790 001032
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Camera = Audio Detection Alert = Clean View Name E- Link

Region Select: choose the appropriate region (state/province) as the default one for detection.
This is the region where the program is typically used to detect cars. In each region (state, city, or
country) there are different methods of numbering license plates, so choosing the correct region
helps make detection more reliable.

Click Apply to commit region selection.

Click Close to close the tab window.

3.4.4. Database Cleanup

This function allows you to cleanup of the database
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Camera Audio ' Detection ' Alert Clean View Name

lean data older than E] BEYE
|

Clean data older than [X] day(s): check to enable Archive Maintenance. Specify the
maximum number of days for the local archive to hold. All data older than X' days will be
deleted.

Click Apply to commit configuration.

Click Close to close the tab window.

3.4.8 View Name

CarDetector allows you to change the name of default views by the following:

Select the View Name tab, the corresponding dialog will displayed
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View 1 Name ‘LEFT
VAN RIGHT |
View 3 Name ROADSIDE

View 4 Name

Enter the new names of views. You can click the On-Screen Keyboard button to open the
keyboard for entering the new name for the View. Click Apply to commit changes.

Click Close to close the View Name tab window.

For example the views can be changed and displayed as follows:

Cameral Camrmeal
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3.4.9 E-Link

E-Link is used to set connection with LEARN Server, perform the following:

Choose E-Link tab to open the corresponding window:

o r— ~" —~"

Camera  Audio tDetectioné Alert | Clean :ViewName E- Link

Connectto LEARN server

vessword

Check the Connect to LEARN Server

Enter the authorized username and password to connect to the LEARN Server. (you can click
On-Screen Keyboard to open the keyboard and then typing the username and password.)

Click Apply to start connecting to the LEARN Server. Click Close to close the dialog.

Once the connection is established, the user can transfer information to and from the LEARN
Server and the E-Link button is Green.

If there is no communication with the LEARN Server the E-Link button will be Red

Note:
LEARN Server is a storage of detection data from CarDetectors via the integrated E-Link.
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3.5. Car Detection

If CarDetector Viewer is connected to the PC running CarDetector MiniPC, the working window is
as follows:

** Note:
It is important to define the appropriate region (state/province) to ensure accurate detection

because there are some differences between plate numbers in different states and/or
provinces. The program utilizes different algorithms to properly analyze a visible license plate
based on the selected state or province.
To define the default country/state/province for detection, select the Setup button and then
select the correct region in the Region Select list.
The license plate number of the most recent detected vehicle will be shown in the Detection
Result window on the right of the screen.
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To view the detected plate with its images, double click on the number in the Detection table the
details dialog will be displayed as follows:

On-Screen Keyboard

21796 001038
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In some case there may be misdetected number, you can correct it by clicking the On-Screen
Keyboard to open the keyboard and then typing the correct one. To finish, click the Update
button.

Note

If a sound is defined in Audio Settings, when any license plate or an alarmed plate is detected by
the application the sound wili be played to alert the operator.

In case that an alarmed car is detected, the picture of the car will be shown in the window as

follows:

To view the communication status of CarDetector with the LEARN Server, click the Status button

to open the window as follows:
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Upload Status Plates Uploaded

Plates Transferred

Plates Buffered

Download Status Plates Downloaded
Total Hot Plates 1501620
Last 24 Hours 1531620
Last12 Hours

Last1 Hour

3.6. Alerting based on a Hot List

In the setup of CarDetector, you can configure a watch list with applied tags (i.e. 'Stolen’, ‘Expired’)
and notes (user-defined) by setting up a list called the Hot List. The Hot List is used for security or
management purposes such as noting the appearance of special cars (cars that have been stolen;
cars of important guests or clients; cars of employees in the company) and sounding an alarm.

When any car in the Hot List is detected, the program will cross-reference the parameters defined
in the Hot List to sound an alarm.

To add to this Hot List for CarDetector, perform the following actions:

- Click the Add Plate button; the Alarm Information dialog will be displayed:
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: On-Screen Keyboard

vomoert) |

IEL A RYCIR High Level v

Expire After
I ours
I -y

To open the keyboard for typing the car plate and other information, click the “on-Screen
Keyboard” button.

F7 0n Screen Keyboard

vt |
FYEY R RAIR High Level - |

Expiwe After
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Number: enter the plate number in Number.
Status: select the alert status for the vehicle
Alarm level: select the desired alarm level for the plate.
Note: enter more information on the alarmed plate (if any)
Owner: enter the name of the car’'s owner (if any)
Expire After: check this option to set an expiration time on the plate, the time may be hours or
days.
- Click the Add button to finish.

When any alarmed car passes the watched area and is detected, the program will play an alarm
sound and the View Info window will be displayed with a picture and relevant information of the
detected plate. Concurrently, the plate number will be displayed in the Hit List.

__HITLIST
M769052

252N138
252N138

252N138
252N138

To review the information about an alarmed car in the Hit List, select its number and click the View
Info button
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Press the Previous or Next to see other alarmed plates detected. Click Close to turn off the
window.

Note:
If the Alarm Match method is '1 off match’, the Detected Number may not be the same as those of a
plate number in the Hot List Number (there may be a one character difference).

If the vehicle is defined High level, when it is detected the number plate will appear with red color,
a medium level is orange and low level is

3.7. Import Hot List

You can import an available hot list or a txt file containing a list of alarmed car numbers to the
current hit list by performing the following:
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Click the Import Hot List button the following dialog will be displayed

Fite to import - I
avarm status - [N

Expire After

Delete Existing Alarms

Look in: | ') Database > | « & ok EB-
Fiename: | Open
Files of type: ITexl Files (*.txt) v | Cancel
ro ead-
pen a8 teackon¥ Y

Choose the Alarm Status for car numbers in the imported file.
Click Apply to finish. Click Close to close the dialog.

3.8. Check Plate
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This function allows you to enter a plate manually and then search for the plate in the database. If
the plate is present it will be shown in the Hot List (if it is on the hot list) or in the Detection Result
window.

Perform the following:

Click the Check Plate button, the following dialog will be displayed:

Exact match

1 off match

To enter the plate, click the On-Screen Keyboard button to open the keyboard for typing the plate.
Click the button again to close the keyboard.

Select the appropriate matching mode.

Click Check. If the plate is found in the ‘detected’ database, the piate image will be displayed in
the Detection Result window

Click Close to finish searching plate.
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3.9. Exit CarDetector Viewer

When the detection process is finished, you can stop the program by performing the following:

Click the Exit button, the program will show the following message:

CarDetector

': Are you sure you want to exit ?

Yes II No I

Click Yes to finish.

21804
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Chapter 4 Database

This chapter provides information about the database of the system.

4.1 Exporting the detection results
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4.1 Export Detection

This function is used to export detection data or the content of the Hit List to another file format for

storage or reference purposes.
Perform the following steps:
First it is necessary to define the period of time for data exporting

Click the 'Shift Start' button to start the shift for data exporting and the button will change to
'Shift End'

After the desired period of time, click the End Shift button to open the dialog to export the shift

report as follows:

e EXPOIt e
All Delete
Hit List

—  Date Time

From IR | EEE—

To:

|
|
|
[
|
i
|
i
!

Badge Number

Badge Numoer N

Choose a data type for exporting:
All Detected: if checked, all detected plates will be exported

Hit List: if checked, all hit list records will be exported
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Date Time: this is the time when you first click the Start Shift button till the time you click the
End Shift button. You can also change the period of time of the report by choosing the desired
time.

Badge Number: check this option and choose the desired badge number if you want to export
the data of the corresponding user.

Delete exported data from system: if checked, all data in this period of time will be removed
from the system database after being exported.

Click the Export button; the Save As dialog will be displayed. Name the export file and click

Save.
Saveh:l@ backup _‘:_J - c¥ E-
Fiename: | Save
Save as lype: IZip Files [*.zip) hd I Cancel |/
y /A
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To make a report on the detection result, click Report; the Detection Report window will be
displayed.

Wl Detection Report ;J_QL)_(J
- View Export report
Records: From: |1 To: [500 Refresh | || Format: [Adobe Acrobat (PDIz] _Expor |
Total: 624 records * ViewRecords ¢ All
,ﬁ' 1 Nl__—l_fl+ l.zdﬂﬁl?_f"/-__zl ,mm‘-@w
Preview |

Urate 12:0352008

1.4 Mobile LPR Edition

34FXF1 09/03/2008
10:35:13:718
2 VTS YTCO75 ] 09/03/2008 ViewilR D 0
YTC G 10:35:15:088
3 TC025 TCD28 09/0672008 MewidR 0 D
‘3L Wk 10:35:15:088
4 o m
5 - - _
T

7 ZDZr93 202793

09/03/2008  View!l-IR 0 0
10:35:10:968
| Wit
D9/03/2008  Viawi-IR ] 0
10:35:19.:968

09/03/2008  Viewi-R 0 0
10:35:22:468

= 09/05/2008 Viewl-R 0 0
10:35:46:790

00/03/2008 View t-IR 0 0
10:38:47 708

(2% J
- -
[

8  644D0F  84400F
GP

Close

There are two types of exporting report:
View Records: check it if you want to export only the data in the Detection report table
All: check it if you want to export all data in the CarDetector database.

Select the desired file format and export mode. Click the Export button.

Export report

Format: [Adobe Acrobat (PDF~] _Expott |

¢~ View Records ¢ All

Click the button — to open the Print dialog for printing the content of the Detection Report.
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Add Printer HP Laserdet  HP LaserJet
1200 Serie...  4100PCL6

1
Status:  Ready Preferences l

Location:- My Documents

Comment: Creates Adobe PDF Find Printer... I

— Page Range

& Al Number of copies:[1 =

€ Selection € Cunent Page

" Pages: | M Collate
Enter page numbers and/or page ranges

separated by commas. For example, 1,5-12

|MICM| »ﬁ-pplyl

Return to the export dialog; click the New Shift button to start a new shift.
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LICENSE REGISTRATION
& UPGRADE PROCESS

Table of Contents:
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1.2 Getting a License KeY.......couevriiriiiinniiiiieiiirccnee e 2
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22 Getting an Upgrade License Key........ccocvcvviiiviiiiniiiiniiiniiicciiiciccicnee 4
23 Using the Upgrade LICENSE........cocvuirvrieriiieiiiieieie ittt 4

1 New License Install
This is a guide for registering a new installation of CarDetector, CamSmartz or LineUp.

1.1 Interface Screen

After running the installation, you will receive a License Code pop-up window when
launching the application.

Siecode: | EREERENS

Machine ID : | 87336CD7-826E-1151

{
E
|
l Daysleft: |14
[
|

License cods : |

[:[um]{nmm](m]

Page 1 1/29/2008
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Please note the following information from this screen:

- Site Code
- Machine ID

1.2 Getting a License Key

Email the above information (‘Site Code’ and ‘Machine ID’) copied/pasted as text, along
with the number of cameras you are requesting a license for, to:

support@vigilantvideo.com
Be sure to include all of the following information:

Subject: LICENSE REQUEST
Body:
Customer Name
Purchase Order Number
Contact Name
Contact Phone Number
Software Title (i.e. CarDetector, CamSmartz or LineUp)
Software Title & Version (i.e. CarDetector 3.0.xxxX.XXXX)
** under Help->About OR on your CDROM**
Site Code
Machine ID
Number of Cameras to Unlock

Please allow up to 24hours for your unlock code to be emailed to you.
NOTE: You may run any of the applications in ‘Trial’ mode for a period of 14 days from

installation on a single camera feed or video clip without registering. Click the “Run
Trial” button to run in the unregistered mode.

1.3 Using the New License

To unlock the application please enter the unlock number emailed to you. After Running
the installation, you will receive a License Code pop-up window when launching the
application.

Page 2 1/29/2008
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CamSmartz

1/29/2008

Site code :

f
Machine ID : | 8733.6CD7-826€ 1151

i Days left : 14 -
i License code : |
E[uwl[nmu}[m]

)

Enter the License Code emailed into the ‘License Code’ entry box (copy/paste from the
email). Once it is unlocked you will receive a message indicating you have unlocked it
successfully. You will have to restart the program after unlocking.

NOTE: If you get a warning saying ‘invalid license code’, be sure you trim all white
space from the beginning and end of the license code. Sometimes a copy/paste will put
in white space characters in the beginning and end of the text box.

2 Upgrading to More Cameras

This is a guide for modifying the number of cameras an existing installation is licensed

for.

2.1 Interface Screen

After installing and registering, you can modify the number of video feeds the application
is licensed for. To begin, click ‘File’ -> ‘Upgrade License’ in the interface. Or click on

the Vigilant Video logo and click Upgrade License.

X

Upgrade camera(s} ’ ﬁ%’%’é« B

Sie code: [ 20000000

| MachinelD: | 0000-0000-0000-0000

New license code : |

f
|
!
I
i
|
{
/

[Getnowiconse | [ uw; }

|
|

Please note the following information from this screen:

- Site Code
- Machine ID

Page 3
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2.2 Getting an Upgrade License Key

Email the above information copied (‘Site Code’ and ‘Machine ID’), along with the
number of cameras you are requesting a license for, to:

support@yvigilantvideo.com
Be sure to include all of the following information:

Subject: LICENSE UPGRADE REQUEST
Body:
Customer Name
Purchase Order Number
Contact Name
Contact Phone Number
Software Title (i.e. CarDetector, CamSmartz or LineUp)
Software Title & Version (i.e. CarDetector 3.0.XXXX.XXXX)
** under Help->About OR on your CDROM**
Site Code
Machine ID
Number of Cameras to Unlock

Please allow up to 24hours for your unlock code to be emailed to you.

2.3 Using the Upgrade License

To upgrade the license code for the application please enter the unlock number emailed to
you. After running, click ‘File’->’License Upgrade’ in the interface menu or Click the
Vigilant Video logo. The following screen will appear:

Upgrade camera(s) !

Site code : ( 00000000

MachinelD: | 0000-0000-0000-0000

Newicensecode:[

Enter the License Code emailed into the ‘New license code:’ entry box (you can
copy/paste from the email) and click ‘Upgrade’. Once it is unlocked you will receive a
message indicating you have unlocked it successfully. You will have to restart the
program after unlocking to use the number of cameras the new license code authorizes.

Page 4 1/29/2008
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NOTE: If you get a warning saying ‘invalid license code’, be sure you trim all white
space from the beginning and end of the license code. Sometimes a copy/paste will put
in white space characters in the beginning and end of the text box.

Page 5 1/29/2008
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“Hot-list” Fundamentals

“KHot-List” — A ‘vehicles of interest’ record set that can be used to identify target vehicles by license plate. This list is
provided by various sources such as the Department of Justice (DOJ), National Crime Information Center (NCIC),
Department of Motor Vehicles (DMV), state Department of Public Safety (DPS), or an internal “Hot-List” by any law
enforcement department or security company.

“Hot-List” formats - Vigilant Video’s Law Enforcement Archival Reporting Network (LEARN) has the built in intelligence to
manage a variety of already available Hot-List files. Additionally a custom Hot-List file can be created using LEARN’s custom
Hot-List template utility.

Available “Hot-List” — Available Hot-List files, such as NCIC, can be automatically managed by LEARN via ‘Remote Hot-List’
functionality. These files are typically characterized by format elements determined by the institutions that govern the
Hot-List. LEARN has a pre-packaged library of standard templates that may be used to interpret many of the commonly
available Hot-List files. Vigilant Video has created the templates for these files based on customer demand.

Custom “Hot-List” — Custom Hot-List files are typically created by law enforcement or security companies specific to their
local objectives. Custom templates may be created in LEARN to manage these files via the “Upload Hot-List” utility.

“Hot-list” Types - LEARN categorizes “Hot-Lists” into three basic ‘Types’ according to LEARN’s User distribution scheme:

Global Hot-List — made available for distribution to ALL LEARN in-network users.

Public Hot-List —-made available ONLY for distribution to users of a ‘Division/Agency’ or ‘Super Agency’

Private Hot-List — made available ONLY to specific assigned User(s) within a Division/Agency.
# o
& &’ &
Private Public Global
Hotlist Hotlist Hotlist

: ol
Private Hothst Publlc Hotlist [{Global Hotlist Global Hotlist
Public Hotlist ~ Public H°"!s‘ Global Hotlist
Global Hotlist Global Hotlist
Trafficking Agency ‘| Narcotics Agency
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“Hot-list” Management Options

& Search Hotlist

Home User Adrmn Detections ¥ EEESININ Hithst Server Auditing ¥ Dashboard ¥ System Settings
4 i i ' - DA Sk P P

Upload Hot-List — This feature is intended to be used with a Hot-List considered to be ‘Static’, or updated manually.
Use ‘Upload Hot-List’ to upload a file into LEARN from a local directory. Using this utility will NOT employ automated
update functionality. Any ‘Static’ file that has a corresponding template may be uploaded into LEARN for distribution
to LEARN’s Users.

Remote Hot-List — This feature is intended to be used with a ‘Dynamic’ Hot-List or one that is remotely managed with
regularly update issues (typically by a 3" party source). Use Remote Hot-List to upload and subscribe to remotely
managed Hot-List files with regularly scheduled updates. Any ‘Dynamic’ file that has a corresponding template may
be uploaded into LEARN for distribution to LEARN’s Users.

Hot-List Template — Use the Hot-List Template utility to create a Template for uploading “Hot-Lists” into LEARN. A
custom Template is necessary in order for LEARN to convert a Hot-List file to a format that complies with LEARN’s
database. The Template is tailored to conform to a specific Hot-List file format.

There are two types of Hot-List templates:

Fixed Width Type —A certain number of spaces (SPACEBAR, ascii character 32) is allocated for each field
Delimiter Type — each field is separated by a certain character

NOTE: Each Hot-List template requires at least two (2) fields - PlatelD & StatelD (denoted in LEARN with an asterisk “*”).

Creating the LEARN “Hot-list” Template

Consider a Fixed Width Template:

Consider a text (txt) file of Hot-List records with the following data set format:

Example Format: format Breakdown:

Name;State;Plate ¢ Row 1 = Header

JohnCAABC123 e For each Subsequent Row:

CarlTXDEF456 o First 4 characters - ‘Name’ field
MarkFL123456 o Next 2 characters - ‘State’field

Bud TXGHI789 o Final 6 characters - ‘Plate Number’ field

Hotlist Basics — LEARN V.4.0 2Ppgo %o 8 2/Q/88s



Creating the Fixed Width LEARN Template:

:emplate: I Stolen_Vehicle_List_1

< Extension I&t

Vﬂeader Row

< @ Fixed Width

Delimter

adding & new or updating an

*)

K2 Ewot  Empon [

Gy Coinpcnns Coinern € Soace i I

Warning: You must select at least 2 mapping values: PlatelD and StatelD for

ja | vehicteOwner
| stateiD(*)
[PlateiD(*)

Wiyl

I {-Empty-- =]
| [~Empty-- =]
| |-Empty-- =l
I {~Empty- =~
[ [~Empty-- =l
| |-Empty- -}
[ {-Empty-- =]
! [-Empty- =]
i [-Empty-- =~}
[ [~Empty-- d
I [~Empty- x|

e Click on the ‘Hotlist Template’ menu tab

e Enter a user defined template name in the Template’ cell (EX. “Stolen_Vehicle_List_1")

e Enter the file extension of the Hot-List source file type (Ex.” txt”)

e Check the ‘Header Row’ box to indicate that the first line of the file is a header

e Select ‘Fixed Width’ to indicate that the Hot-List file format is fixed width type

e Input the ‘Field from User File’ for each data point — For fixed width, the entry will be the number of

characters allocated to each field:

o Enter “4” for the Vehicle Owner
o Enter “2” for the State Identification
o Enter “6” for the Plate Number
e For the ‘LEARN equivalent’ section, select the cells that best describe these data points

o Field 1 - VehicleOwner
o Field 2 —StatelD
o Field 3 - PlatelD

e Click ‘Add New’ to add this Template to the existing library of LEARN Templates

The Template has been successfully created and may now be used with ‘Remote’ or ‘Upload’ Hot-List Functions

Hotlist Basics — LEARN V.4.0
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Consider a Delimiter Template:

Consider a Comma Separated Value (csv) file of Hot-List records with the following data set format:

Example Format: Format Breakdown:

Owner;State;Plate e Row 1 =Header

John;CA;ABC123 ¢ For each Subsequent Row:
Carl;TX;DEF456 o First character group - ‘Owner’ field
Mark;FL;123456 o Next character group - ‘State’ field

o Final character group - ‘Plate’ field

Note — This format differs from the Fixed Width format where a semicolon (;) separates the data fields

Creating the Delimiter Width LEARN Template:

[Fe!lony_Warrant_Listj - - : [ LEARNEquvalet 1
IOwner | VehicleOwner |
| StatelD(*) -]
Header Row

v

c h ——a
Fixed Widt | F—Emmy EI
oot : { {-~Empty-- -l
Mma (‘ Space O Other I [ r'EmPfY“ 7]

Warning: You must select at least 2 mapping values: PlatelD and StatelD for

Mphte or updating an existing template l [--Empty- ll
< oo 7o) oy : l [--Empty-— ;I

e (Click on the ‘Hotlist Template’ menu tab

e Enter the user defined template name in the Template’ cell (EX. “Fellony_Warrant_List_7")
e Enter the file extension of the Hot-List source file type (Ex.” csv”)

e Check the ‘Header Row’ box to indicate that the first line of the file is a header

e Select ‘Delimiter’ to indicate that the Hot-List file format is Delimited type

e Select the Delimiter character — In the example choose the semi-colon “;
¢ Input the ‘Field from User File’ information - for Delimiter, this entry will be used as a User defined label for
each data point:
o Field 1 - Enter “Owner”; Field 2 - Enter “State”; Field 3 - Enter “Plate”
e For the ‘LEARN equivalent’ section, select the cells that best describe these data points
o Field 1 — VehicleOwner; Field 2 — StatelD; Field 3 - PlatelD
e Click ‘Add New’ to add this Template to the existing library of LEARN Templates

The Template has been successfully created and may now be used with ‘Remote’ or ‘Upload’ Hot-List Functions

Hotlist Basics — LEARN V.4.0 PpgaArf 8 2/03/%%



Upload “Hot-list” to LEARN (Static)

Once a Template has been created in LEARN, a Hot-List file may be Uploaded and made available for LEARN Users
and CarDetector license plate recognition applications.

There are two (2) ways to use the ‘Upload Hot-List utility— Upload Hot-List File and Upload Hot-List Plate.

Upload “Hot-List” File

|
P (“!Add — e (Click on the ‘Hotlist’ on the menu tab
* Uplcad Hoth ct Plate
I e Select the ‘Upload Hotlist’ option
Template: [ca-D0J B e Select the Hot-List file Template from the pull down library

Select File: [C Documents 2 Browse... ! of template options

e Browse to the location of the Hot-List file

Eia size must be less than ICME

e Enter a Description of the Hot-List file

Description: ICA DOJ Stolen List . "
e Search Type - Select ‘Exact Match’ or ‘1-Off’ historical alert

Search Type: [Exact match K o This setting is used for historical Hot-List matching
Type Upload:  [Public R —i.e. when a hot-list is updated, LEARN will search
Source oy the existing LPR record base for matches against
Level: |Lowi ~] the updated records
I Expire After: "30_ day(s) e Select the distribution ‘Type Upload’ for the Hot-List
=<@ o Global; Public; or Private
e Select the priority level of the Hot-List records

N o Low; Medium; or High

e Set an expiration time period if applicable

e Once the expiration period is reached, the Hot-List file
records will become inactive

e (lick ‘Upload’ to upload the Hot-List file to LEARN

FileName: I

JSearch |

LEARN “Hot-List” Record Management

Static Hot-List File - The Upload Hot-List utility is intended for ‘Static’ files. Adding or subtracting records to any
LEARN Hot-List file via the ‘Upload Hot-List’ utility must be conducted manually.

Adding Multiple Records to an Existing LEARN Hot-List File - Prepare a data file that conforms to the ‘Static’ Hot-
List file’s template and repeat the steps above - new records will be added as an additional “Hot-List File.

5 Adding Single Records to an Existing LEARN Hot-List File -Follow the steps above using the “Add Hot Plate” in
lieu of using ‘Upload Hot-List’ in the ‘Upload Hot-List’ menu tab — Complete the form and click ‘Add’.

——» Removing Single or Multiple Records from an Existing LEARN Hot-List File - Removing records is done by

uploading records with the use of ‘Remove’. Follow the steps above as if you were adding single/multiple Hot-List
records to an existing Hot-List. Select the ‘Remove’ option prior to uploading the changes — the records will be
rendered ‘Inactive’ from the existing LEARN Hot-List file. Alternatively Hot-List records may be removed via the
Delete function — See “More Hot-List Basics” below.

Hotlist Basics — LEARN V.4.0 Ppg2orf 8 2/08/091



Using the Remote “Hot-list” Utility (Dynamic)

Once a Hot-List template has been created in LEARN, a remote Hot-List file subscription may be set up and made
available for LEARN Users and CarDetector license plate recognition applications.

Set Up the Remote “Hot-List” File Subscription

e Click on the ‘Hotlist’ on the menu tab
Schedule name: IDaily NYSPIN . . .
e Select the ‘Remote Hotlist’ option
1P Address: [72'46‘184 32 e Enter a ‘Schedule Name’ (User Defined)
User name: INYSPD_74421 e Enter the ‘IP Address’,’ User name’ & ‘Password’
Password: l"““"“ Please Note: IP Address, User name and Password
Directery: |F \Home\NYS\LPR\D} inputs are used for SFTP and FTP transactions only
Template: |NY-NYSPIN _':j e Enter the directory in which the Hot-List file resides
Search type: [Exact match :_l e Select the Hot-List file Template from the pull down
UploadType: [Global _v_] library of LEARN Template options
Zipped: Cvyes G No e Search Type - Select ‘Exact Match’ or ‘1-Off historical alert
MH’P Crre € Local o This is used for historical Hot-List Alert matching
— 1 Load Type: @ complete e Select the ‘Upload Type’ to be assigned to the Hot-List
€ Incremental o Global; Public; or Private
Source INYSPIN_DMV ¢ Indicate if the Hot-List file is native or zipped
Frequency: o Select the Type of Server (See Below)
Goaiy: |9 x]15 ¥ e Select the ‘Load Type’
 Weekiy: M sun [ Mon I Tue T wed o Complete or Incremental (See Below)
Mthe i T osat e Enter a Source Name (See Below)
l : :Jf Z..l e Choose the frequency for LEARN to automatically update
€ Every: | minute(s) the record set, acquire and distribute to LEARN Users
By Add new | e Click ‘Add New’ to activate the subscription to the remote

Hot-List file = LEARN will immediately acquire the file
e Select the Hot-List schedule (Not Shown) and click ‘Run’

Dynamic Hot-List File - The ‘Remote Hot-List’ utility is intended for subscription to ‘Dynamic’ files which are
updated by 3" party sources. Maintenance or changes to any Remote LEARN Hot-List files are automatically
managed by LEARN at a frequency designated by the LEARN User.

<: SFTP / FTP — Remote Hot-List subscriptions will be Secure (SFTP) or standard (FTP) File Transfer Protocol.

Local Subscription — Many institutions that compile sensitive data lists may insist on ‘pushing’ the Hot-List to a
law enforcement agency’s network. LEARN provides a directory on the local network in which to store the
incoming Hot-List data. LEARN will subscribe to the information (provided by the external source) and distribute
the Hot-List changes within the LEARN network — Use the ‘Local’ setting to accommodate this type of data
delivery.

Hotlist Basics - LEARN V.4.0 Prgefo 8 2/09403,



Source Name - The Source Name is used by LEARN when managing ‘Complete’ Load Type subscriptions. The ‘Source
Name’ allows LEARN to compare incoming ‘Complete’ Hot-List files against like-kind ‘Source Name’ files previously
uploaded via the Remote Hot-List process.

Complete Vs. Incremental - Complete and Incremental Load Type settings define how the files are managed by the
remote administrator (or Local via Push). These settings define the methodology of the 3" party file updates.

‘Complete’ Load Type ~ This is used when a 3" party administrator offers LEARN access to a Hot-List where the Hot-
List file is updated in its entirety. This means that each time the 3" party administrator updates the Hot-List, a new
and complete Hot-List file is added to the file set in the directory to which LEARN subscribes.

‘Complete’ Load Type Example:

e Law enforcement agency “A” has obtained the permissions to subscribe to their respective state’s
Department of Public Safety’s (DPS) available Hot-List data for license plate recognition
e DPS manages the records on a remote server. Each time DPS updates the record set, they add a new file
to the directory that contains the most up-to-date complete list of all vehicle records
» Law enforcement agency “A” will subscribe to the DPS record set by using their assigned credentials and
set the Load Type to ‘Complete’ with a ‘Source Name’ of “DPS_Records”
e During the scheduled update LEARN will retrieve the newest file and upload all new vehicle records
o Existing Hot-List records corresponding to the Source Name “DPS_Records” will become Inactive
o New Hot-List records (Source Name = “DPS_Records”) will now become the active record set
o The net difference between Hot-List record sets will be distributed to in-network CarDetector
applications

‘Incremental’ Load Type - This is used when a 3" party administrator offers LEARN access to a Hot-List where the
Hot-List file is updated by posting an additional file to the Hot-List directory, whereby the sum total of all files
represents the complete record set. This is often done by using a designation character as one of the record data
points that represents the status of the record (active / inactive).

‘Incremental’ Load Type Example:

e Law enforcement agency “B” has obtained the permissions to subscribe to their respective state’s
Department of Public Safety’s (DPS) available Hot-List data for license plate recognition
e DPS manages the remote server records - Each time DPS updates the record set, they add a new file to
the directory that contains a) new vehicle additions and b) vehicles that should “fall off” the old record
list (Indicated as inactive) - Essentially a record set indicating net changes to the Hot-List
e Law enforcement agency “B” will subscribe to the DPS record set by using their assigned credentials and
set the Load Type to ‘Incremental’ — No ‘Source Name’ is required
e During the scheduled update LEARN will retrieve the newest file and upload the additional vehicle
records (both new vehicle records as well as vehicle records to be made ‘Inactive’)
o All new vehicle records will be added to the Hot-List
o All existing Hot-List records will be compared to the list of records to be rendered inactive
o The net difference between Hot-List record sets will be distributed to in-network CarDetector
applications
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Using ‘Search Hot-List’

T L R

More “Hotlist” Basics

Server Auditing ¥

Dashboard ¥

Syster Settings

& Search Hotlist & Upload Hotlist & Remote Hotlist @ Hotlist Files & Hotlist Template

Change Password Log out

@ All Time

To:

UserName:

Order No.:

€ Time From:

Vehicle Licensa No:

Vehicle VIN:
Hotlist Type:

Vehicle License St:

~-MyHotList--
Pablo
Rolando
John

Eqt 123456CA 123456

Edi 1224B5CA 122485

Cca
2= |132456 fca
CA

Hello, Division/Agency HarzewPD

211672009 120223 PM  Joe

Result: 4 record(s)

HarzewPD private

LAgRtgeIc2 e lRon Harzewn oD enate

21672009 12:0223 P Dan

et DR F- IR SRV

HarzewPD private

D Giekad

Enter search criterion

Click ‘Search’

View Hot-List records at a glance

____“Hot-List” Record Information
RONCCAS24BDT

Update Hot-List records
Delete single or multiple Hot-List records
View detailed Hot-List Record Information

I|117 -

‘ Source

IVehicIe License No| 524B0T Notesl 5612 Eastwood Drive
iVehicle vin 62F CXA736UUHCI90ST5251 (NotesZ Burbank

IVehicle License St | CA Motes3

foate of order | 211509 12:31:23 PM Notesd

IAIarm Status Stolen Vehicle NotesS

HVehicle Model Mercedes Benz C350

'Vehicle Owner Joseph Silverman

For questions or concerns, please contact Vigilant Video’s support team:

Hotlist Basics — LEARN V.4.0

support@vigilantvideo.com

925-398-2079

PpeFof 8

2/09/094






